
Descriptions ofTellMeAdd-ons

To obtain the most current descriptions of TellMe Add-ons, please visit our World Wide Web 
home page on the Internet at:

http://www.IcebergSoftware.com

Each copy of TellMe is packaged and distributed as a TellMe Starter Kit, which includes the    
basic search software, plus a copy of several dozen DataBases designed to make TellMe 
useful right out of the blocks.    Several data templates (“DataConnections”) are also supplied 
to allow the user to enter personal information for use with TellMe. 

The real value of TellMe is driven by the availability of Add-On DataBases and 
DataConnections that allow the user to expand the depth and breadth of information they can 
access using TellMe’s simple interface.    Iceberg distributes Add-Ons electronically via its 
Internet web site (http://www.IcebergSoftware.com) and a selection of commercial on-line 
services.    For those customers without on-line capabilities, Add-Ons will also be made 
available on magnetic media, and may be ordered direct from Iceberg at 1.888.283.5563 
(1.888.2TELLME). 

Iceberg has arranged the initial set of planned TellMe Add-Ons via the following categories:

Category Add-On Available

Registration Premium “WhenIs” 3/15/96

Financial Matters Financial Terms 5/15/96
Business Reference 5/15/96
Currency Exchange Rates 6/15/96

Geography World Geography Reference 5/15/96
US Cities - Complete 3/15/96

Travel Traveler’s Resource 5/15/96
Foreign Cities Weather (monthly averages temp & rain) 4/18/96
US Cities Weather (monthly averages temp & rain) 4/18/96
US Cities Mileages 6/15/96

Kids Fun & Interesting Internet URL’s 4/18/96

DataConnections Symantec - Act! 5/1/96
Lotus - Organizer 5/21/96

Writing Tools    Webster’s School & Office Dictionary 5/1/96
Famous Quotes 6/1/96
Spell Checker 5/15/96



Abbreviations 5/15/96
Biographical Summaries 5/15/96
Geographical    Summaries 5/15/96
Foreign Words & Phrases 6/15/96

Directory Assistance Online Service Directory 4/18/96
Internet Web Addresses URL’s - Medium (600) 4/18/96
Internet Web Addresses URL’s - Large (8,000) 6/15/96
Beige Pages - Top 200 5/1/96
Who Knows What 5/15/96

Reference “About Series” 5/15/96
Signs & Symbols 6/1/96
Table of Measurements 6/1/96
Computer Terms 6/1/96

Sports/Entertainment Sports Resource 5/15/96
Entertainment Resource 5/15/96

Note: This listing is subject to change without notice.

________________________________________________________________________________________________________________
__

Product Descriptions

WhenIs

WhenIs -- a TellMe database which provides information about upcoming events: holidays, 
sporting events, entertainment specials, tradeshows, etc. Helps you keep track of events you 
may want to attend or watch on television. WhenIs is not sold as a separate data base; instead, 
it is supplied free of charge to registered TellMe users. If you have not yet registered your 
copy of TellMe, please do so via our web site at www.IcebergSoftware.com or call Iceberg at 
888.283.5563 (1.888.2TELLME) and get a free copy of the WhenIs data base.

Financial Matters

Financial Terms -- Provides definitions for 3,000+ terms used in financial markets. The 
definitions includes range from such fundamental words as stock to more specialized 
concepts such as lookback call option. 

Business Reference -- A general-purpose tool for people in business. Includes
· sections on business law, government, communications, corporate administration, 
finance, human resources, manufacturing, marketing, office management, and international 



business
· directories of resources (such as industry newsletters or environmental organizations) and 
potential suppliers or business partners
· tables of reference data, including the Forbes 400 wealthiest people, the Inc. 500 fastest-
growing companies, etc.

Currency Exchange Rates -- Provides current exchange rates between the dollar and foreign 
currencies.    Requires the user to have access to the internet.

Geography

World Geography Reference -- includes demographic, governmental, economic and historical 
information for countries around the world. 

US Cities: Complete -- provides area codes, ZIP codes, time zone and population for 50,000-
plus cities in the US. 

Travel

Traveler's Resource -- includes information useful to travelers: 
· telephone country codes (to and from foreign countries)
· time zones, currencies, languages for other countries
· airport information
· diplomatic personnel and embassies
· mileage between cities
· temperature and weather by season

Foreign Cities Weather -- a subset of the Traveler's Resource, providing average monthly 
temperature and number of rain days for cities overseas. 

US Cities Weather -- a subset of the Traveler's Resource, providing average monthly 
temperature and number of rain days for U.S. cities. 

US Cities Mileages – Provides distance (in miles) information between 300 U.S. cities.

Kids

Web Addresses (URLs) for Kids -- Locations on the Internet's World Wide Web, selected for 
their appeal to young people. 

Data Connections

Symantec: Act! -- Allows you to use TellMe to access your information which is stored in 
Symantec’s Act! Contact management software application. 

Lotus: Organizer -- Allows you to use TellMe to access your information which is stored in 



Lotus Organizer. 

Other Personal Information Managers -- Under development. Please send e-mail to 
Suggestions@IcebergSoftware.com and let us know which PIM you use.

Writing Tools

AHD Dictionary -- Provides definitions, pronunciation and etymology for 34,000-plus words. 

Webster’s School & Office Dictionary -- Provides definitions, pronunciation and etymology 
for 60,000-plus words.

Quotations -- Includes 5,600 quotations; based on Simpson's Contemporary Quotations

Spell Checker -- Allows you to check the spelling of a word, even if your word processor is 
not running. 

Abbreviations -- Find the abbreviation you need for a word or phrase, or look up the meaning 
of an abbreviation that you don't recognize. 

Biographical Summaries -- Provides a quick reference to check "Who was so-and-so?"
 

Geographical Summaries -- Helps you find out "Where on earth is such-a-place?" 

Foreign words and phrases -- Now, when you cannot decipher that unfamiliar phrase from 
the context of the passage you are reading, you can look it up quickly and easily! 

Directory Assistance

Online Directory -- Where to find information online. Tells you which online service(s) have 
information for which information providers, and what command to use to access the 
information.  

Internet Web Addresses (URLs) -- Locations on the Internet's World Wide Web. 

The Beige Pages -- Information about companies in the personal computer industry: 
products, technical support resources, phones & faxes, addresses (both physical and 
electronic). Includes hardware and software suppliers. 

Who Knows What – A directory of thousand’s information resources organized under 500 
distinct categories.

Reference



The “About Series” -- Includes specialized databases which allow you to request "TellMe    
About …" information for topics in each of these subject areas:

· The Bible
· American History to and since 1865
· Mythology and Folklore
· World & American Politics
· Proverbs
· World & American Geography
· Idioms
· Anthropology, Psychology, and Sociology
· World Literature, Philosophy, and Religion
· Business and Economics
· Literature in English
· Physical Sciences and Mathematics
· Conventions in Written English
· Earth & Life Sciences
· Fine Arts
· Medicine and Health
· World History to and since 1550
· Technology

Signs and Symbols -- A ready-reference of symbols from mathematics and other sciences.

Table of Measurements --  units of measure and conversion formulas for the US and metric 
systems, and for scientific measurement. 

Dictionary of Computer Terms -- definitions of specialty terms used in the computer industry.



Please register your copy of TellMe

A reminder: Please be sure to register your copy of TellMe with Iceberg Software. Once 
you have completed the registration process, you will receive the free    electronic 
database entitled WhenIs, which contains information about upcoming events: holidays, 
sporting events, entertainment specials, trade shows, etc. You can register in either of 
two ways:

1. You can    visit our World Wide Web home page on the Internet at:

http://www.IcebergSoftware.com

Once there, you can choose the "Registration" item, and submit your registration online. 
If you register over the Internet, you can receive your copy of WhenIs immediately, via 
download from the Web site (invoked automatically after you've registered). Unless the 
Internet is really busy when you register, this download should take less than 5 minutes 
using a 9600 baud modem.    (You are responsible for paying any Internet costs for the 
time needed to download the WhenIs file.)

2. Alternatively, TellMe contains a registration capability: from the Help menu, choose 
the item entitled "Register TellMe". Once you have completed the form, you can print it 
out and then either mail or fax it to Iceberg. The fax number for registrations is 800-671-
5830. When you give us your e-mail address on your registration form, we will send 
your free copy of the WhenIs database via electronic mail. (A shipping and handling fee 
of $5 applies if you need a floppy-disk copy of WhenIs sent via mail; please include your 
Visa or MasterCard account number and expiration date, or mail a check payable to 
Iceberg Software, L.L.C.)

Thank you for registering your copy of TellMe! 

Click here to Continue
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How to use TellMe 

TellMe is a personal data retrieval tool that helps you find information that you have stored 
on your computer or network. 

To learn how to use help, Press F1.

Contents for How to Use Help

If you are new to Help, choose Help Basics. Use the scroll bar to view 
information not visible in the Help window. 

To choose a Help topic

Click the underlined topic you want to view. Or press TAB to select the topic, and then 
press ENTER. 

Help Basics

Windows Help offers a quick way to find information, such as how to perform a 
particular task. Within a Help topic, there may be one or more jumps, which you can click 
(or select and press ENTER) to display a new Help topic. 

You can move, resize, maximize, or minimize the Help window, just like any other 
window. 

To return to Contents for How To Use Help, choose the Contents button. 

 
Sample Screen Layout 

 

 
Commands and Buttons

File Menu Commands 

Use the scroll bar to see more commands.

 Print 

Sends entire search string and result directly to selected printer. For example:

the phone number for Bob Smith is 703.555.1234



Cancel is supported.

Fax 

Sends entire search string and result directly to the selected fax send device. For 
example:

the phone number for Bob Smith is 703.555.1234

Cancel is supported.    The fax device must be in TellMe (use Settings | Preferences) 
and installed as a supported printer in the Windows Control Panel.

Dial 

Dials phone number displayed in the Answer Box via the modem.    The dialing 
configuration for the modem is established in Settings followed by Preferences.

Save As

Sends entire search string and result to a disk file (which you select) in ASCII text 
(.TXT) format.

Exit (terminates the application)

Edit Menu Commands 

 Cut 

Copies the search result (as displayed in the Answer Box) into the clipboard and 
clears the display in the Answer Box.    For example, the clipboard might contain:

703.555.1234

Copy 

Copies the search result (as displayed in the Answer Box) into the clipboard and 
leaves Answer Box display intact.    For example, the clipboard might contain:

703.555.1234

Paste 

Enters existing clipboard contents into the Value Box to facilitate the next TellMe 
search.



Data Menu Commands 

Source 

Displays the source of the data (from the immediately previous search) in the Answer 
Box.

Create Starter Kit Diskette

This command will create a copy of the TellMe Starter Kit by copying the necessary 
files to a diskette. Please share copies of the Starter Kit with whomever you like.

Settings Menu Commands

Use the scroll bar to see more commands.

Hotkeys Setup 

This feature is not implemented in this version of TellMe.

Preferences 

Enables user to use TellMe to dial through a modem, and to link his existing fax 
application to TellMe by defining the fax device.

Modem/Dial Setup

Enables the user to configure the modem to dial phone numbers that are displayed 
in the Answer Box at the conclusion of a TellMe search.    Note: The user must 
have a telephone handset connected to the modem so he can talk to the desired 
party once the modem completes the dialing procedure.

Port

User can select from the following serial ports: COM1, COM2, COM3 or 
COM4 (indicating where the modem is connected).

Dial String

User specifies a modem command (if any) required to initiate dialing by the 
modem.

Dial Prefix



User selects a numeric prefix (if any) required for all calls.

Dial Prefix (Long Distance)

User selects a numeric prefix (if any) required for long distance dialing.

Area Code

User specifies the area code for his current location; this allows TellMe to 
not dial that area code, even if the value is stored in the database being 
searched. 

 
Interface Type

This feature is not implemented in this version of TellMe.

Fax

Enables the user to specify the fax driver to be used by TellMe for faxing output 
(see the File menu). The fax device must be already installed as a supported 
printer in the Windows Control Panel. 

Enter Customer Number 

Iceberg Software assigns a unique customer number to every TellMe user when they 
register their copy of TellMe.    This customer number allows Iceberg to better track 
customers, what DataBases they have purchased, preferences, configuration, etc.    
When you register with Iceberg and receive your Customer Number, please enter it 
into TellMe as soon as possible.

Always on Top  

Toggle command: when "on" the    TellMe application window (either in minimized or 
full-sized form) will appear "on top" of all other applications.    When a check mark 
appears directly to the left of the Always on Top menu item, the option is "on"; 
when the check mark disappears, the option is off. Note that this feature is useful on 
Windows 3.x systems; for Windows 95 users, the Windows system Taskbar provides 
a similar capability.

Run at Startup 

Toggle command: when "on" TellMe will be loaded into memory every time 
Windows is launched. When "off", TellMe must be launched manually by selecting its 
icon and double clicking on it (or clicking on it once and pressing the "enter" key). 
When a check mark appears directly to the left of    the Run at Startup menu item, 
the option is "on", when the check mark disappears, the option is off.



Toolbar 

Toggle command: turns display of the Toolbar (which is located directly beneath the 
File menu) on and off.    When a check mark appears directly to the left of    the 
Toolbar menu item, the toolbar display option is "on", when the check mark 
disappears, the toolbar display option is off.    The display is turned on and off by 
selecting that item with the mouse.

Help Menu Commands 

Contents 

Provides access to the Help information for TellMe.

Search for Help On…

Allows the user to search the keywords in the Help information for TellMe.

Register TellMe

Allows the user to enter information needed to register a copy of TellMe with Iceberg 
Software. Once the information has been entered, the resulting registration form can 
be printed and mailed or faxed directly to Iceberg. See also Please register your 
copy of   TellMe  

Add-on Descriptions

Provides information about add-on products (additional DataBases and 
DataConnections) which are available for use with TellMe.

Order Add-Ons

Allows the user to enter information needed to order add-on products from Iceberg 
Software. Once the information has been entered, the resulting order form can be 
printed and mailed or faxed directly to Iceberg. 

About TellMe 

Displays the About box for TellMe.

 
Tool Bar Buttons 

There are eight tool bar buttons that appear on the TellMe main screen.    These buttons 



are designed to provide convenient access to frequently used TellMe commands. 

 

Click here to return to Help Contents.



How to add your own Data toTellMe

To help you put your own information into TellMe, the Starter Kit includes four Data 
Templates -- these are regular Microsoft Excel spreadsheets (.XLS files) which you can edit 
using Excel (version 5 or version 7) to contain your own data. The four Data Templates are

AddrBook.XLS          Address Book
SerialNr.XLS            Serial Numbers and Warranty Information
OfficeEx.XLS Office Extensions
MyWallet.XLS My Wallet

The Address Book allows you to store names, addresses, phone and fax numbers, and e-mail 
addresses for your friends, family members and business associates. The Serial Numbers file 
helps you keep track of serial numbers and warranty expiration dates for items you own 
(appliances, consumer electronics, etc.). The Office Extensions file allows you to store 
telephone extensions (voice and/or fax) and e-mail addresses for the colleagues who work in 
your office. The My Wallet file lets you keep personal data (insurance policy numbers, credit 
card numbers, frequent flyer accounts, etc.) 

To edit any of these files, you only need to start Excel, then use the File | Open command to 
open the file you wish to edit. [Note that the files are stored in the "Template" subdirectory of 
your TellMe directory; if you used the default location for TellMe (C:\TELLME), then the 
Excel templates are stored in C:\TELLME\TEMPLATE.] Once you have opened the file, you 
may add or correct any of the information in the file. Then simply use the File | Save 
command to save your work. Be sure to use the File | Close or File | Exit commands in Excel 
before you try to access the file using TellMe; if Excel still has the data file open, you will get 
an error message from TellMe (Registry error -- Unable to find xls file.). The following table 
will help you know which Excel file to edit for a given TellMe request:

Filename TellMe Request
AddrBook.xls Address for Name
AddrBook.xls Phone for Name
SerialNr.xls Serial # for Manufacturer/Model #
SerialNr.xls Warranty Pd / Date for Manufacturer/Model #
MyWallet.xls Account Number for Issuer
OfficeEx.xls Extension for Name
OfficeEx.xls Name for Extension
OfficeEx.xls e-mail for Name
OfficeEx.xls Fax for Name

Remember that you must use Excel version 5 or version 7 to edit these Data Templates; 
earlier versions of Excel are not able to save the .XLS file in the correct file format. When 
you install these versions of Excel, they automatically install the necessary OLE2 support 
files (OLE2.DLL, STORAGE.DLL, and COMPOBJ.DLL) in your \WINDOWS\SYSTEM 
directory.

The current version of TellMe (Version 1.0) requires that Excel be installed on the PC where 
TellMe is running in order to use the above features. We are planning to remove this 
restriction in the future; this would allow you to create (or edit) your data files on a PC which 



includes Excel, then to distribute the data files to other PCs which would not need Excel to 
access those data files. Once this version is available, you can get it from our    World Wide 
Web home page on the Internet at:

http://www.IcebergSoftware.com

Click here to Continue



How to get More Data forTellMe

To obtain additional DataBases or DataConnections for TellMe, please visit our World Wide 
Web home page on the Internet at:

http://www.IcebergSoftware.com

If you don't have access to the Internet, you can call us toll-free at 1-888-2TELLME (1-888-
283-5563) to place an order.    You can also order additional TellMe products by selecting 
Order Add-On(s) from the Help menu, and then faxing your completed order to Iceberg 
Software for processing.

            Related Topics:

Descriptions of   TellMe   Add-Ons   
Contacting Iceberg Software 



Contacting Iceberg Software

For assistance or for more information, please visit our Iceberg home page on the Internet's 
World Wide Web:

http://www.IcebergSoftware.com

To register TellMe or place an order via telephone, please call us toll-free at 1-888-
2TELLME (1-888-283-5563).

To register TellMe or place an order via fax, please call 1-800-671-5830.

For technical assistance, or customer service please call 1-900-288-2345.    Please note that 
this is a toll call (you are charged $2.00 per minute).

For other topics (not including technical support) contact:

      Iceberg Software, L.L.C.
      201 Elden Street -- Suite 187
      Herndon, VA 22070
      703-435-3427
      Fax: 703-435-9049

Related Topics:

How to get More Data for TellMe 



About TellMe

 

Click here to continue



DataBases

DataBases are the special compilations of information which are sold as TellMe add-ons, to allow TellMe 
to access this information on their own computers or networks. These DataBases must be obtained by 
licensing them (and usually by paying a fee for each user)    from the publisher of each DataBase. 
DataBases may not be copied or distributed to other users.



Personal Information Manager (PIM)

One of a group of software products, developed to allow PC users to store their own personal information 
in a PC. This information typically includes

schedule information
list(s) of "things to do"
personal contacts: names, addresses, telephone numbers for friends, colleagues, customers, etc.

Examples of PIM products are

ECCO from NetManage
Organizer from Lotus
Schedule+ from Microsoft
ACT! from Symantec

TellMe will allow you to access your PIM information without having to load the PIM program.



DataConnections

DataConnections are the special software components which allow TellMe to access data from other 
applications, such as reference data bases or a Personal Information Manager (PIM). These 
DataConnections must be obtained by licensing them (and usually by paying a fee for each user)    from 
the developer of each DataConnection. DataConnections may not be copied or distributed to other users.



The TellMe Starter Kit

The Starter Kit consists of the TellMe search engine (the TELLME.EXE program) plus all of the 
included DataBases and DataConnections. You are welcome to distribute the TellMe Starter kit 
to your friends.    This data includes:

800 Numbers    (Hotels & Airlines)
Area Codes & Time Zones (US Cities)
ASCII Codes
The Beige Pages (Top 50 Hardware/Software Companies)
Binary Conversions (1-100)
Countries: Population & Capital
Entertainment Software (Games) Rating Definitions
Flash Cards - Geography images (U.S. state outlines)
Hex Conversions (1-100)
Inches Conversion (Fractional inch, millimeters for 0.x", millimeters for 1/x" )
Interesting Internet Addresses (Web URL's)
Month Information (birthstone, number of days)
Movie Rating Definitions
Numbers 1-100
Delivery Price Schedules
Shop Conversions (volume, temperature, length)
States: Population & Capital
Super Bowl Scores
US Cities - Sample (For the top 1800 cities only) -- City population, ZIP code
US Income Tax Rates (Federal 1995 returns)
Wedding Anniversary Gifts (traditional and modern)

The following Data Templates are available in the first commercial release of TellMe 1.0:

My Personal Address Book (Data templates)
My Wallet      (Data templates)
Office Extension (Data templates)
My Serial Numbers    (Data templates)

Related topics:

Please share TellMe with your friends
TellMe License Agreement 



TELLME.EXE program

The main program component of the TellMe product. This is the file which you may copy and give to your 
friends.

Related topics:

Please share TellMe with your friends
TellMe License Agreement



Please shareTellMewith your friends

You are welcome to share your copy of the TellMe Starter Kit with your friends and family.    
The Starter Kit consists of the TellMe search engine (the TELLME.EXE program) plus all of 
the included DataBases and DataConnections. To make a copy of theTellMe Starter Kit, 
simply use the Create Starter Kit Diskette command on the Data menu. Please note that 
you are not allowed to share copies of any TellMe DataBases or DataConnections that you 
have acquired that were not included in the TellMe Starter Kit.

For more information, please see the TellMe   License Agreement  .



TellMe Starter Kit License Agreement

ICEBERG END USER LICENSE AGREEMENT
IMPORTANT --    READ CAREFULLY BEFORE INSTALLING SOFTWARE 
PACKAGE(S). Unless a separate multilingual license is included in your product 
package, the following License Agreement applies to you.

TellMe Starter Kit by Iceberg Software, L.L.C. (“ICEBERG”)

This Agreement is your license to use the copyrighted program, data, and documentation that 
comprise the TellMe Starter Kit (the “System”), subject to the limitations explained below.    This 
right to use the TellMe Starter Kit is granted to you upon the condition that you accept the terms 
of this license.    YOUR USE OF THE SYSTEM, BY INSTALLING IT ON A COMPUTER, A 
NETWORK OR OTHERWISE, INDICATES YOUR ACCEPTANCE OF ALL THE TERMS OF 
THIS LICENSE.

THIS TRANSACTION IS NOT THE SALE OF A SOFTWARE PRODUCT BUT A LICENSE 
AGREEMENT. THE PROGRAM, DATA AND PROGRAM DOCUMENTATION ARE 
FURNISHED TO MAKE THE TELLME STARTER KIT AVAILABLE FOR YOUR USE AND 
REMAIN THE PROPERTY OF ICEBERG.

IF YOU DO NOT AGREE WITH ANY PART OF THIS LICENSE, DO NOT USE THE 
SYSTEM.    DELETE THE TELLME STARTER KIT MATERIALS AND DOCUMENTATION 
FROM YOUR COMPUTER(S) AND DESTROY ANY BACKUP COPIES THEREOF WITHIN 
10 (TEN) DAYS OF RECEIPT AND THIS LICENSE WILL BE TERMINATED.

LICENSE TERMS AND CONDITIONS
TellMe Starter Kit SYSTEM
The Licensed System consists of Licensor's methods (including any and all patents issued and 
applied for) for the organization, storage, retrieval and display of tabular, graphical and textual 
reference data, Licensor's copyrighted computer program and documentation for the use of those 
methods, and a proprietary reference data compilation.    The software, data compilation, and 
each screen display and printout generated by the System (or any component thereof) are 
protected by U.S. and foreign copyright. Iceberg Software is a Service Mark and TellMe is a 
Trademark, both of which are the property of Iceberg Software, L.L.C. Any add-on products 
which bear an authorized “Connects to TellMe” logo (including, without limitation, data bases, 
data connections and/or data tools) licensed by Iceberg or its third party licensees (the “Add-on 
Products”) are not included in the TellMe Starter Kit and are not covered by this License.

YOUR USE OF THE SYSTEM
Visual Reference Use.    The System is licensed only for general visual reference in your home, 
business or institution. 
Prohibitions on Use.    You have not been granted any right to use the System for the purpose of: 
(i) producing data base material in any form or on any media for publication or distribution 
outside your home, business or institution, (ii) extracting data from TellMe Starter Kit for non-



transitory storage on other electronic, magnetic or optical media or otherwise using the System to 
create, alter or supplement any other database; (iii) combining operation of the System 
interactively with operation of other software or using other software to manipulate and deploy 
data extracted from the System, other than your system BIOS, your operating system, or 
Microsoft Windows except that, if separately licensed by Iceberg or its licensees, you may use 
the System to interoperate with other Add-On Products, in accordance with the terms of both 
licenses.
Computer Use.    Your right to use the System is limited to use on one or more computer(s) 
consisting of a CPU equipped with a keyboard and a display screen.    Network use of the System 
is authorized, provided that all network users of the System accept all the terms of this license.    
Electronic reproduction and transmission of output to remote locations are permitted, solely as 
provided for via program commands on the File menu.
No Modifications or Decompilation; Restricted Right to Redistribute.    You have no right to 
modify the System in any way, incorporate it into a compilation, or create any derivative work, 
except that you may use documented TellMe commands to reproduce the TellMe Starter Kit in its 
entirety. Once the TellMe Starter Kit has been reproduced as authorized in this License, you may 
distribute the reproduced copy, if and only if the reproduced copy includes this License. You may 
not reverse assemble, reverse engineer, or decompile the System, or otherwise obtain access to 
the source code of the retrieval program or to the logical structure and contents of the database.

COPY LIMITATIONS
Electronic and Storage Media.    You have the right to load elements of the System onto the 
hard disk of your computer, using only the installation program supplied, to load elements of the 
System into RAM and the CPU of your computer as required during normal operation of the 
System and, using the System, to retrieve and display the data on a screen. You do not have the 
right to reproduce any part of the System in any other way except for output and TellMe Starter 
Kits reproduced as authorized above.
Backup Copies. You may also make a single copy of the System for backup and archival 
purposes.

WARRANTIES; DISCLAIMER
NO WARRANTY. ANY USE OF THE SOFTWARE PRODUCT IS AT YOUR OWN RISK.    
THE SOFTWARE PRODUCT IS PROVIDED FOR USE ONLY WITH MICROSOFT 
WINDOWS 3.1 AND MICROSOFT WINDOWS 95. TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, ICEBERG AND ITS SUPPLIERS DISCLAIM ALL 
WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, AND NONINFRINGEMENT.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL ICEBERG OR ITS 
SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR 
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY 
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE SYSTEM, EVEN IF 



ICEBERG HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE 
SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE 
ABOVE LIMITATION MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY.    ICEBERG'S ENTIRE LIABILITY AND YOUR 
EXCLUSIVE REMEDY UNDER THIS AGREEMENT SHALL NOT EXCEED FIVE 
DOLLARS (US$5.00).

TERMINATION AND TRANSFER OF THIS LICENSE
By You: You may terminate this license at will. UPON TERMINATION OF THIS LICENSE 
YOU AGREE TO DESTROY ALL COPIES OF THE SYSTEM FURNISHED TO YOU, 
INCLUDING ANY BACKUPS AND UNAUTHORIZED COPIES OF THE SYSTEM OR ANY 
PORTION THEREOF.
By Iceberg: Iceberg reserves the right to terminate this License if you have exceeded or 
attempted to exceed the licensed uses in any way.    Termination will be effected by written or 
electronic notice to you. UPON TERMINATION OF THIS LICENSE YOU AGREE TO 
DESTROY ALL COPIES OF THE SYSTEM FURNISHED TO YOU, INCLUDING ANY 
UNAUTHORIZED COPIES OF THE SYSTEM OR ANY PORTION THEREOF. 
Transfer: YOU ARE AUTHORIZED TO TRANSFER YOUR SINGLE-USER LICENSE 
RIGHTS ONLY UPON THE CONDITIONS THAT: (1) YOU TRANSFER ALL OF THEM; (2) 
THE TRANSFEREE ACCEPTS ALL TERMS AND CONDITIONS OF THIS LICENSE; AND 
(3) YOU DELIVER ALL COPIES OF ANY PART OF THE LICENSED SYSTEM AND THE 
DOCUMENTATION TO THE TRANSFEREE.    Transferees of the Iceberg TellMe Starter Kit 
License are encouraged to register with Iceberg in order to receive news of the future updates to 
this and other Iceberg programs.

MISCELLANEOUS
This Agreement is governed by the laws of the Commonwealth of Virginia,    U.S.A.

Should you have any questions concerning this Agreement, or if you desire to contact Iceberg for 
any reason, please write to Iceberg at the address below. 

U.S. GOVERNMENT RESTRICTED RIGHTS
Use, duplication, or disclosure by the Government is subject to restrictions as set forth in 
subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software Restricted 
Rights clause at FAR 52.227-19 (JUN 1987) as applicable.    Contractor/manufacturer is:

Iceberg Software, L.L.C., 201 Elden Street, Suite 187, Herndon, Virginia 22070 
(703) 435-3427.

revised 2/23/96
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